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ACHTUNG:
Die Software wird dem Benutzer in der vorliegenden Form zur Verfügung gestellt. Alle Risiken
hinsichtlich der Qualität und der durch ihren Einsatz ermittelten Ergebnisse verbleiben beim
Benutzer. Entsprechende Sicherheitsvorkehrungen gegen eventuelle Fehlbedienungen sind
vom Benutzer vorzusehen.
Wir übernehmen keine Verantwortung für direkt oder indirekt entstandene Schäden, z. B.
Gewinnverluste, Auftragsverluste oder geschäftliche Beeinträchtigungen jeglicher Art.

CAUTION:
The software is made available to the user in the form presented here. All risks concerning
the quality and all results occuring from the use remain the responsibility of the user.The user
must provide the corresponding safety measures to protect the softwareagainst incorrect use.

We do not accept any liability for directly or indirectly occuring damages, e.g. profit losses,
order losses or any business interferences.

. 1999 Lenze GmbH & Co KG

Ohne besondere schriftliche Genehmigung von Lenze GmbH &Co KGdarf kein Teil dieser Dokumenta-
tion vervielfältigt oder Dritten zugänglich gemacht werden.

Wir haben alle Angaben in dieser Dokumentation mit größter Sorgfalt zusammengestellt und auf Über-
einstimmung mit der beschriebenen Hard- und Software geprüft. Trotzdem können wir Abweichungen
nicht ganz ausschließen. Wir übernehmen keine juristische Verantwortung oder Haftung für Schäden,
die dadurch eventuell entstehen. Notwendige Korrekturen werden wir in die nachfolgenden Auflagen
einarbeiten.

Windows, Windows 95 und MS-DOS sind eingetragene Warenzeichen der Microsoft Corporation.
IBM und VGA sind eingetragene Warenzeichen von International Business Machines, Inc.
Alle anderen Markennamen sind Warenzeichen ihrer jeweiligen Besitzer.

No part of these Instructions may be copied or given to third parties without written approval of Lenze
Lenze GmbH & Co KG.

All indications given in these Operating instructions have been carefully selected and comply with the
hardware and software described. Nevertheless, deviations cannot be ruled out. We do not accept any
responsibility or liability for damages which might possibly occur. Necessary corrections will be made
in the following editions.

Windows, Windows 95 and MS-DOS are registered trademards of the Microsoft Corporation.
IBM and VGA are registered trademarks of the International Business Machines, Inc.
All other brand names are trademarks of the corresponding owners.

Version 1.1 09/99
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1 Vorwort
Das Programm Global Drive Control (GDC)dient zur komfortablen Inbetriebnahme und Parametrierung
der Global Drive Antriebsreihen 8200 und 9300.

Die wesentlichen Eigenschaften von GDC sind:
• Geführte Inbetriebnahme mittels antriebsspezifischen Dialogen
• Menügeführte Parametrierung. Gleichzeitige Darstellung des Menüs und der zugeordneten

Codestellen ähnlich des Windows-Dateimanagers/Explorers.
• Parametrierung mit und ohne direkter Kopplung per serieller Schnittstelle zum Antriebsregler

(Online-/Offline-Betrieb). Hierdurch Vorabparametrierung im Bürobereich möglich.
• Vereinfachte Funktionsblockparametrierung für Antriebsregler 93xx.
• Automatische Antriebserkennung beim Betrieb mit serieller Schnittstelle.
• Kommunikation über serielle Schnittstelle RS232/485, LWL-Ring oder Systembus möglich.
• Vereinfachte Fehlersuche durch Diagnose-Funktionen.
• Monitorfenster zur Darstellung von 8 Parametern, die zyklisch aktualisiert werden. Die Werte

können durch unterschiedliche Visualisierungsfomen (Zeigerinstrument, Balken, Trend, Zahl)
dargestellt werden.

• Oszilloskopfunktion für Antriebsregler 93xx.
(93xx Servo ab Softwarestand 2.0, 93xx Vector ab Softwarestand 1.0)

• Funktionsblock-Editor für Antriebsregler 93xx.
• PC-Parametersatzvergleich mit der Lenze-Werkseinstellung oder der aktuellen

Antriebseinstellung, um festzustellen, welche Änderungen in der Parametrierung vorgenommen
wurden.

• Kompletter Parametersatztransfer zwischen PC und Antriebsregler mit einem Befehl.
• Ausdruck der Parametereinstellungen zur Dokumentation, Speichern/Laden der

Antriebskonfiguration zum Austausch zwischen verschiedenen Rechnern.
• Komfortables Online-Hilfesystem.

1.1 Was ist neu?

Stand Id-Nr. Änderungen

1.0 10/98 00403781 Erstauflage

1.1 09/99 00410149 Zweisprachig Deutsch/Englisch

1.2 Lieferumfang

Lieferumfang Wichtig

• 1 CD-ROM “Global
Drive Control”

• 1 Kurzanleitung

Überprüfen Sie nach Erhalt der Lieferung sofort, ob der Lieferumfang mit den Waren-
begleitpapieren übereinstimmt. Für nachträglich reklamierte Mängel übernimmt
Lenze keine Gewährleistung.
Reklamieren Sie
• erkennbare Transportschäden sofort beim Anlieferer.
• erkennbare Mängel/Unvollständigkeit sofort bei der zuständigen Lenze-Vertretung.
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2 Systemanforderungen
Um mit dem Programm GDC arbeiten zu können, sind folgende Mindestanforderungen an Hard- und
Software zu erfüllen:

Global Drive Control 16-Bit-Version Global Drive Control 32-Bit-Version

• Microsoft Windows 3.11 oder Windows 95
• 16 MByte RAM

• Microsoft Windows 95/98/NT 4.0
• 32 MByte RAM

• IBM-kompatibler PC (CPU: 80486DX/33 Prozessor oder höher)
• Super-VGA Bildschirm
• Festplatte mit min. 30 MByte freier Festplattenkapazität
• CD-ROM Laufwerk
• freie serielle Schnittstelle für die Kommunikation mit dem Antriebsregler
Desweiteren empfehlen wir die Verwendung einer Maus.

2.1 Von Global Drive Control unterstützte Schnittstellen

Für die Kommunikation zwischen PC und Antriebsregler unterstützt GDC folgende Schnittstellen:

Schnittstelle Übertragungs-
medium

max. Anzahl
Antriebsregler

erforderliche Komponenten Bestellbezeichnung

serielle
Schnittstelle
(COM-Port)

RS232/RS485* RS232: 1
RS485: 31

Feldbusmodul 2102IB EMF2102IB V001

PC-Systemkabel RS232/485, 5m EWL0020

LWL 52 Feldbusmodul 2102IB EMF2102IB V003

LWL-Adapter EMF2125IB

Netzteil für LWL-Adapter EJ0013

LWL-Kabel EWZ0007

parallele
Schnittstelle
(LPT-Port)

Systembus 63 PC-Sytembusmodul EMF2173IB

*RS485 wird derzeit nur von der Global Drive Control 16-Bit-Version unterstützt.

Um mit dem Antriebsregler zu kommunizieren, verbinden Sie den Antriebsregler mit dem PC über die
entsprechende Schnittstelle (COM-/LPT-Port).

Hinweise
• Das Programm GDC ist auf die serielle Schnittstelle COM2 voreingestellt.
• Wenn Sie eine andere Schnittstelle verwenden, können sie diese in den

Kommunikationseinstellungen von GDC entsprechend konfigurieren. (�7)
• Weitere Hinweise zur Kommunikation mit dem Antriebsregler finden Sie in der

GDC-Online-Hilfe.
• Informationen zu den Feldbusmodulen entnehmen Sie bitte der entsprechenden

Betriebsanleitung.
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3 Software-Installation
Um die Software GDC auf Ihrem Rechner zu installieren, führen Sie folgende Schritte aus:
1. Starten Sie Windows.
2. Legen Sie die Global Drive CD in Ihr CD-ROM-Laufwerk ein.

Ist die Autostart-Funktion Ihres CD-ROM-Laufwerks aktiviert (Windows 95/98/NT), wird das
Installationsprogramm automatisch gestartet und Sie können mit Schritt 5 fortfahren.

3. Wählen Sie im Programm-Manager Datei → Ausführen (Windows 3.11)
bzw. im Startmenü Ausführen... (Windows 95/98/NT).

4. Geben Sie in die Befehlszeile den Laufwerksbuchstaben Ihres CD-ROM-Laufwerks gefolgt von
“:\gdc_inst\setup.exe” ein und bestätigen Sie mit Ok.

5. Folgen Sie den Anweisungen des Installationsprogramms.

3.1 Auswahl von Komponenten

Im Installationsprogramm von GDC können Sie auswählen, welche Komponenten von GDC installiert
werden sollen:

Abb. 1 Dialogfenster “Installationsauswahl”

• Global Drive Control - GDC-Programmdateien und GDC-Online-Hilfe
• Gerätebeschreibung... - von GDC benötigte Daten für den jeweiligen Antriebsregler
• Online-Hilfen - zusätzliche Online-Hilfen zu den Antriebsreglern 82xx/93xx
• CAN-Anschaltung - von GDC benötigte Dateien für die Kommunikation über Systembus
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4 Erste Schritte mit Global Drive Control

4.1 Allgemeines

Das Programm GDC unterscheidet zwischen Online- und Offline-Modus.
• Offline:

Es besteht keine Verbindung zum Antriebsregler. Dieser Modus ist sinnvoll zur
Vorparametrierung bzw. zur Dokumentation der Parametrierung im Büro. Außer dem PC sind
keine weiteren Komponenten erforderlich.

• Online:
GDC kommuniziert über die serielle/parallele Schnittstelle des PC mit dem Antriebsregler. Diese
Betriebsart ist für die Inbetriebnahme des Antriebsreglers erforderlich.

4.2 Starten des Programms

• Windows 3.11:
Doppelklicken Sie im Programm-Manager in der Programmgruppe “Global Drive Control” auf
das Icon “Global Drive Control”.

• Windows 95/98/NT:
Klicken Sie im Startmenü/Untermenü Programme in der Programmgruppe “Global Drive
Control” auf den Eintrag “Global Drive Control”.
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Nach dem ersten Programmstart erscheint folgendes Dialogfenster, in dem Sie zwischen Online- und
Offline-Modus auswählen können:

Abb. 2 Dialogfenster “Lecom-A/B - Antriebe suchen”

Schaltfläche Funktion/Hinweise

Suchen Sucht nach an der Schnittstelle COM2 (Voreinstellung) angeschlossenen Antriebsreglern und startet GDC
im Online-Modus.
Wenn Sie statt COM2 eine andere Schnittstelle verwenden:
1. Wählen Sie die Schaltfläche Abbruch, um das Dialogfenster zu schließen.
2. Wählen Sie im Menü Optionen → Kommunikation, um die Kommunikationseinstellungen zu

ändern.
3. Starten Sie eine erneute Suche. (Siehe Kap. 4.3)
Weitere Informationen zu den Kommunikationseinstellungen finden Sie in der GDC-Online-Hilfe.

� 8

Abbruch Schließt das Dialogfenster, ohne nach Antriebsreglern zu suchen und startet GDC im Online-Modus. � 8

Offline Schließt das Dialogfenster, ohne nach Antriebsreglern zu suchen und startet GDC im Offline-Modus. � 9

Hilfe Ruft die GDC-Online-Hilfe mit gezielten Informationen zu diesem Dialogfenster auf.
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4.3 Antriebsregler suchen (Online-Modus)

Das Dialogfenster “Antriebe suchen” wird automatisch geöffnet, wenn GDC im Online-Modus gestartet
wird.
• Sie können das Dialogfenster “Antriebe suchen” auch über eine der folgenden Möglichkeiten

aufrufen:
– Drücken Sie die Funktionstaste F2
– Wählen Sie im Menü Antriebsregler → Suchen

– Klicken Sie in der Symbolleiste auf die Schaltfläche

Für die Suche können Sie folgende Einstellungen vornehmen: (siehe auch Abb. 2)
• Alle Baudraten durchsuchen:

Aktivieren Sie das Kontrollkästchen, um alle Baudraten von 1200 bis 19200 Baud durchsuchen
zu lassen.

• Suche abbrechen, sobald ein Antrieb gefunden wird:
Aktivieren Sie das Kontrollkästchen, um die Suche abzubrechen, sobald ein Antrieb gefunden
wurde.

• Geräteadressen:
Geben Sie in die Eingabefelder den Bereich der Geräteadressen ein, nach denen gesucht
werden soll.

Wählen Sie die Schaltfläche Suchen, um die Suche zu starten oder Abbruch, um die Suche abzubre-
chen.
• Am Bus gefundene Antriebsregler werden im Fenster “Antriebe am Bus” aufgelistet. (�13)
• Für die gefundenen Antriebsregler versucht GDC automatisch, Gerätebeschreibungen

zuzuordnen.
– Wurde nur ein Antrieb gefunden und eine Gerätebeschreibung konnte zugeordnet werden,

wird diese sofort geladen.
– Gelingt die automatische Zuordnung der Gerätebeschreibung für einen Antrieb nicht, kann für

diesen Antrieb die Gerätebeschreibung manuell zugeordnet werden.
Um den Dialog für die manuelle Zuordnung zu öffnen, aktivieren Sie den entsprechenden
Antriebsregler im Fenster “Antriebe am Bus”
oder wählen Sie im Offline-Modus im Menü Antriebsregler → Wählen. (�9)
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4.4 Antriebsregler wählen (Offline-Modus)

ImModusOffline müssenSie denverwendetenAntriebsregler zunächst überdas Dialogfenster “Geräte-
beschreibung zuordnen” manuell auswählen.
1. Rufen Sie das Dialogfenster “Gerätebeschreibung zuordnen” über eine der folgenden

Möglichkeiten auf:
– Drücken Sie die Funktionstaste F3
– Wählen Sie im Menü Antriebsregler → Wählen

– Klicken Sie in der Symbolleiste auf die Schaltfläche

�

Abb. 3 Dialogfenster “Gerätebeschreibung zuordnen”

2. Wählen Sie im Listenfeld� den Antriebsregler aus, den Sie parametrieren möchten.
3. Wählen Sie die Schaltfläche Ok, um die Auswahl zu übernehmen oder Abbruch, um die

Zuordnung der Gerätebeschreibung abzubrechen.
Bei Auswahl der Schaltfläche Ok wird die Gerätebeschreibung des Antriebsreglers daraufhin in GDC
geladen.
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4.5 Kurzinbetriebnahme

Nachdem die Gerätebeschreibung des ausgewählten/gefundenen Antriebsreglers in GDC geladen
wurde, wird in der GDC-Voreinstellung automatisch das Dialogfenster “Kurzinbetriebnahme” geöffnet.

4.5.1 Beispiele für den Kurzinbetriebnahme-Dialog

�

ô í ÷ û ø

ù

Abb. 4 Dialogfenster “Kurzinbetriebnahme-Dialog” (Beispiele)
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Die Funktionen im Dialogfenster “Kurzinbetriebnahme” sind abhängig von der geladenen Gerätebe-
schreibung und werden daher an dieser Stelle nur beispielhaft erklärt.
Weitere Informationen zum jeweiligen Dialog finden Sie in der GDC-Online-Hilfe.

Feld Schaltfläche Funktion/Hinweise

� Änderung der Einstellungen zur ausgewählten Konfiguration

ô Hilfe Anzeige der Online-Hilfe
• Über die Schaltfläche Hilfe können Sie von jedem Dialogfenster aus die Online-

Hilfe mit gezielten Informationen zum Dialogfenster aufrufen.
• Allgemeine Informationen zum Umgang mit der Windows-Hilfe finden Sie in Ihrer

Windows-Dokumentation.

í Start • Startet den Antriebsregler
– nur im Online-Modus

÷ Stop • Stoppt den Antriebsregler
– nur im Online-Modus

û Diagnose Wechsel zum Dialogfenster “Diagnose”
• Anzeige von Überwachungskonfiguration, Betriebszeit, Fehlermeldungen, usw.

ø Parametermenü Beenden des Dialogs Kurzinbetriebnahme und Anzeige des Parametermenüs
• Zum Umgang mit dem Parametermenü siehe Kap. 4.6, “Die Bedienoberfläche

von Global-Drive-Control”. (� 12)

ù Steuerung Wechsel zum Dialogfenster “Steuerung”
• Über das Dialogfenster “Steuerung” kann der Antriebsregler einfach in Betrieb

genommen werden.
– nur im Online-Modus
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4.6 Die Bedienoberfläche von Global Drive Control

4.6.1 Fenster

In GDC gibt es vier verschiedene Fenstertypen.

Hauptfenster

� ô

í ÷

Abb. 5 Hauptfenster

Das Haupfenster von GDC enthält
• das Hauptmenü�, (�17)
• die Symbolleiste ô, (�18)
• die Statuszeile í, (�19)
• und den GDC-Arbeitsbereich÷.
Das Hauptfenster ist das eigentliche Anwendungsfenster von GDC. Alle anderen Fenster sind Doku-
mentfenster, die nur innerhalb dieses Anwendungsfensters angezeigt werden können. Funktionen zur
Anordnung der Anwendungsfenster sind im Menü Fenster untergebracht.
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Antriebe am Bus

Abb. 6 Fenster “Antriebe am Bus”

Im Fenster “Antriebe am Bus” werden alle verfügbaren Antriebsregler aufgelistet. WählenSie indiesem
Fenster den Antriebsregler aus, den Sie parametrieren möchten.

Parameterfenster

Abb. 7 Fenster “Parameterfenster”

Nachdem für einen Antriebsregler die entsprechende Gerätebeschreibung in GDC geladen wurde, steht
das Parameterfenster zur Verfügung. Mit Hilfe dieses Fensters können auf einfache Art und Weise alle
Antriebssystem-spezifischen Einstellungen des Antriebsreglers vorgenommen werden.
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Hinweis
In dieser Kurzanleitung wird der generelle Umgang mit dem Parameterfenster erklärt.
Weiterführende Informationen finden Sie in der GDC-Online-Hilfe und in der Dokumentation zu Ihrem
Antriebsregler.

Das Parameterfenster ist in zwei Bereiche unterteilt:
• Auf der linken Seite befindet sich das Parametermenü, hier können Sie den Menüpunkt

auswählen, für den Sie Einstellungen vornehmen möchten.
• Die rechte Seite dient für Ausgaben zum im Parametermenü aktiviertem Menüpunkt, in Abb. 7

z. B. eine Tabelle mit den relevanten Codestellen für den Drehzahlbetrieb.

Symbole im Parametermenü und ihre Bedeutung

Menüpunkt im Parametermenü, nicht ausgewählt.
• Doppelklicken Sie auf das Symbol, um den Menüpunkt auszuwählen.

Menüpunkt im Parametermenü, der weitere Untermenüpunkte enthält. Die Untermenüpunkte sind ausgeblendet.
• Doppelklicken Sie auf das Symbol, um die Untermenüpunkte einzublenden.

Menüpunkt im Parametermenü, der weitere Untermenüpunkte enthält. Die Untermenüpunkte sind eingeblendet.
• Doppelklicken Sie auf das Symbol, um die Untermenüpunkte auszublenden.

Menüpunkt im Parametermenü, ausgewählt.
• Die rechte Seite des Parameterfenster dient für Ausgaben zu diesem aktivierten Menüpunkt.
• Bei Menüpunkten, die mit “Dialog” beginnen, wird stattdessen ein Dialogfenster geöffnet.

– Wählen Sie die Schaltfläche Zurück bzw. Parametermenü, um dieses Dialogfenster wieder zu schließen.

Auf Codestellen des Antriebsreglers kann über Tabellen zugegriffen werden, die auf der rechten Seite
des Parameterfensters angezeigt werden.
• Sie können eine Codestelle mit der linken/rechten Maustaste oder den Pfeiltasten auswählen.

– Die linke Maustaste öffnet gleichzeitig den Eingabedialog, anderenfalls müssen Sie noch die
Taste Enter betätigen, um den Eingabedialog zu öffnen.

– Der Eingabedialog läßt sich nur öffnen, wenn die ausgewählte Codestelle ein Schreiben des
Wertes zum Antriebsregler zuläßt.

• Sie können sich durch Betätigen der Funktionstaste F1 weitere Informationen zur ausgewählten
Codestelle anzeigen lassen.
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Der Eingabedialog ist abhängig von der Art der Codestelle:

�

í

÷

ô

Abb. 8 Mögliche Eingabedialoge für das Anzeigen und Ändern von Codestellen

Darstellungsart der Code-
stelle im Eingabedialog

Hinweise

� Liste Aus einer Liste können Sie für die ausgewählte Codestelle eine neue Einstellung wählen.
• Der aktuell eingestellte Wert ist beim Öffnen des Eingabedialogs in der Liste selektiert.

ô Hexadezimal Der Wert der Codestelle ist bitcodiert.
• In einer Liste werden alle Bits und ihre Bedeutung aufgeführt.
• Den ausgewählten Wert können Sie mit der linken Maustaste oder mit der Leertaste zwischen

0 und 1 wechseln.
• Alternativ können Sie der Wert der Codestelle Dezimal bzw. Hexadezimal eingeben.

í Dezimal Innerhalb eines angezeigten Zahlenbereiches können Sie den Wert der Codestelle über die Tasta-
tur eingeben.

÷ Dezimal, zusätzlich
schrittweise Änderung
möglich.

Innerhalb eines angezeigten Zahlenbereiches können Sie den Wert der Codestelle über die Tasta-
tur eingeben.
• Zusätzlich können Sie den Wert mit Hilfe der Schaltflächen Up und Down in festen Schritten

verändern.
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Schaltflächen in den Eingabedialogen und ihre Bedeutung

Ok Der selektierte/eingegebene Wert wird übernommen, der Eingabedialog wird beendet.
• Im Online-Modus wird der Wert zum Antriebsregler übertragen.*

Übernahme Der selektierte/eingegebene Wert wird übernommen, der Eingabedialog bleibt aber geöffnet.
• Im Online-Modus wird der Wert zum Antriebsregler übertragen.*

Abbruch Der Eingabedialog wird abgebrochen, gegebenenfalls durchgeführte Änderungen werden verworfen.

Hilfe Weitere Informationen zur ausgewählten Codestelle werden angezeigt.

*Einige Codestellen können im Online-Modus nur geändert werden, wenn im Antriebsregler die Reglersperre gesetzt ist.

Monitorfenster

Das Monitorfenster dient zur Anzeige von Werten, die zyklisch vom Antriebsregler gelesen werden.
• Das Monitorfenster ist nur im Online-Modus aktiv.
• Im Offline-Modus wird das Monitorfenster automatisch zum Symbol verkleinert.

Abb. 9 Monitorfenster

• Klicken Sie mit der linken Maustaste auf ein Teilfenster, um es zu vergrößern. Ein weiterer
Mausklick stellt die vorherige Ansicht wieder her.

• Klicken Sie mit der rechten Maustaste auf ein Teilfenster, um das Dialogfenster
“Monitorkonfiguration” zum Konfigurieren der Darstellung zu öffnen.
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4.6.2 Hauptmenü

Neben den häufig verwendeten Funktionen, die z. B. über die Symbolleiste oder die Funktionstasten
zugänglich sind, enthält das Hauptmenü von GDC zahlreiche spezielle Funktionen, die entsprechend
ihrer Funktionalität in Untermenüs gruppiert sind.
In Abhängigkeit des ausgewählten Antriebsreglers und des gewählten Modus (Online/Offline) kann es
sein, daß ein Untermenü ausgeblendet ist bzw. Funktionen in diesem Untermenü abgeblendet sind. Ab-
geblendete Funktionen können nicht aufgerufen werden.

Untermenü Funktionen Hinweise

Antriebsregler • Suchen/Wählen/Start/Stop
• Kommunikationsparameter
• GDC beenden

� 8, 9

Antriebspara-
meter

• Parametersatztransfer PCÛ Antriebsregler
• Parameter laden/speichern/drucken

• Untermenü wird nur im Online-Mo-
dus angezeigt.

� Online-Hilfe

FB-Editor • spezielle Funktionsblock-Editor-Funktionen • Untermenü wird nur bei aktiviertem
Funktionsblock-Editor angezeigt.

• nur Antriebsregler 93xx

� 20

Oszilloskop • spezielle Oszilloskop-Funktionen • Untermenü wird nur bei aktiviertem
Oszilloskop angezeigt.

• nur Antriebsregler 93xx
ab Softwarestand 2.x

� 21

Tool • Aufruf von benutzerdefinierbaren Tools von
GDC aus

• Aufruf von optionalen GDC-Komponenten
(FB-Editor, Oszilloskop)

• In dieses Untermenü können externe
Programme eingebunden werden,
die dann direkt von GDC aus aufge-
rufen werden können.

� Online-Hilfe

Optionen • Voreinstellungen zum Programm � Online-Hilfe

Fenster • Anordnung der Fenster

Hilfe • Anzeige der Online-Hilfe
• Informationen zum Programm
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4.6.3 Symbolleiste

Über die Symbolleiste haben Sie einen bequemen Zugriff auf häufig benötigte Funktionen. Alternativ
zur Symbolleiste können Sie für viele Funktionen auch die Funktionstasten Ihrer PC-Tastatur verwen-
den.

Schaltfläche
aktiviert

Schaltfläche
deaktiviert

Funktions-
taste

Funktion

F1 Anzeige der kontextsensitiven Hilfe.
• Allgemeine Informationen zum Umgang mit der Windows-

Hilfe finden Sie in Ihrer Windows-Dokumentation.

Antriebsfenster schließen.

F2 Antriebsregler suchen. � 8

F3 Antriebsregler wählen. � 9

F4 Umschalten zwischen Online-/Offline-Modus � 8
� 9

F5 Parametersatz vom PC zum Antriebsregler übertragen.
• nur im Online-Modus

F6 Markierten Parameter vom Antriebsregler in den PC übertragen.
• nur im Online-Modus

F7 Parametersatz vom Antriebsregler in den PC übertragen.
• nur im Online-Modus

F8 Antriebsregler starten.
• nur im Online-Modus

F9 Antriebsregler stoppen.
• nur im Online-Modus

Funktionsblock-Editor starten.
• nur bei Antriebsreglern 93xx

� 20

Oszilloskopfunktion starten.
• nur bei Antriebsreglern

– 93xx Servo ab Softwarestand 2.0
– 93xx Vector ab Softwarestand 1.0

� 21
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4.6.4 Statuszeile

� îô ÷í ùøû ü

Abb. 10 Statuszeile

Angezeigte Informationen in der Statuszeile

� Hinweise zu gerätespezifischen Parametermenüs.

ô/í Statusinformationen bei antriebsspezifischen Dialogen.

÷ TRIP: Störung im Antriebsregler aufgetreten.

û RSP: Reglersperre im Antriebsregler gesetzt.

ø IMP: Impulssperre im Antriebsregler gesetzt.

ù Aktueller Modus (Online/Offline)

î Online-Adresse (CAN oder LECOM-A/B)

ü Uhrzeit
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4.7 Funktionsblock-Editor

Der Funktionsblock-Editor ist ein leistungsfähiges Werkzeug, mit dem Signalkonfigurationen in Lenze-
Antriebsreglern 93xx erstellt, diagnostiziert und analysiert werden können.

• Klicken Sie in der Symbolleiste auf die Schaltfläche , um das Dialogfenster “FB-Editor”
zu öffnen.

Abb. 11 Dialogfenster “FB-Editor”

Signalkonfiguration erstellen

Mit Hilfe desMauszeigers lassensichVerbindungenzwischenFunktionsblöckenherstellen sowie beste-
hende Verknüpfungen entfernen. Darüber hinaus können die Parameter der Funktionsblöcke (Z. B.
Hochlauframpe oder Maximaldrehzahl) mit dem Funktionsblock-Editor eingestellt werden.

Signalkonfiguration diagnostizieren

An den Ein- und Ausgängen der Funktionsblöcke lassen sich Istwerte einblenden, die zyklisch aktuali-
siert werden. Diese Signale können durch Mausklick von Funktionsblock zu Funktionsblock verfolgt
werden, um Fehler im Signalfluß aufzuspüren. Außerdem liefert der Funktionsblock-Editor Informatio-
nen zur Abarbeitungsreihenfolge der einzelnen Funktionsblöcke.

Signalkonfiguration analysieren

Jeder Funktionsblock, der in derSignalkonfiguration verwendet wird, kanngrafisch dargestellt werden.
Einzelne Signale (z. B. Drehzahlsollwert) lassen sich mit Hilfe des Mauszeigers durch die gesamte Si-
gnalkonfiguration verfolgen. Dabei geben die Parameter der Funktionsblöcke Aufschluß über die jewei-
lige Funktion.
Weitere Informationen zum Funktionsblock-Editor erhalten Sie, indem Sie im
Menü Hilfe → Funktionsblockeditor wählen.
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4.8 Oszilloskopfunktion

Für Antriebsregler 93xx Servo ab Softwarestand 2.0 (93xx Vector ab Softwarestand 1.0) verfügt GDC
über eine Oszilloskopfunktion.

• Klicken Sie in der Symbolleiste auf die Schaltfläche , um das Dialogfenster
“Oszilloskop” zu öffnen.

Abb. 12 Dialogfenster “Oszilloskop”

Die Oszilloskopfunktion dient zur Messung beliebiger Signale, die vom Antriebsregler verarbeitet
werden. Dazu befindet sich im Antriebsregler ein Funktionsblock (OSZ), derwie einSpeicheroszilloskop
arbeitet. Dieser Funktionsblock kann bis zu vier analoge Signale gleichzeitig messen und aufzeichnen.
Die Triggerung erfolgt entweder über einen zusätzlichen digitalen Eingang oderüber einender vier ana-
logen Kanäle.
Die Speicherung der Daten erfolgt im Antriebsregler. Nach Abschlußeiner Messungwerden diese Daten
zum PC übertragen und mit Hilfe der Oszilloskopfunktion in GDC visualisiert.
Die Kommunikation zwischen Antriebsregler und Visualisierungsfunktion ist nur möglich über
• LECOM-A/B
• Systembus
Weitere Informationen zur Oszilloskop-Funktion erhalten Sie, indem Sie im
Menü “Hilfe → Oszilloskop“ wählen.
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5 Anhang

5.1 Häufig gestellte Fragen und Antworten

Fehler Ursache Abhilfe

Parametersatzdateien
können nicht eingelesen
werden.

Sie haben versucht, Parametersatzdateien
einzulesen, die mit dem DOS-Programm
“Lemoc2” hergestellt wurden.

GDC verwendet für die Ablage der Antriebsparameter
ein anderes Dateiformat.
Übertragen Sie den Parametrsatz aus den Antriebsreg-
ler in den PC und speichern Sie diesen mit GDC ab.

Keine Kommunikation
mit dem Antriebsregler.

Es wird ein falsches PC-Systemkabel ver-
wendet.

Überprüfen Sie die Verdrahtung des Systemkabels.
(Die Belegung des Systemkabels finden Sie in der
GDC-Online-Hilfe.)

Antriebsregler ist ausgeschaltet bzw. das
LECOM-A/B-Modul 2102 hat keine Span-
nung.

Antriebsregler mit Spannung versorgen und korrekte
Verbindung mit dem Antriebsregler überprüfen.
Bei externer Spannungsversorgung an den Klemmen
39 und 59 die Spannung überprüfen (siehe Betriebsan-
leitung zum Antriebsregler).

Es wurde der falsche COM-Port gewählt. Im Menü Optionen → Kommunikation wählen, um
den verwendeten COM-Port einzustellen.

Die Schnittstellenparameter sind nicht kor-
rekt eingestellt.

Mit Hilfe der Windows-Systemsteuerung können die
Schnittstellenparameter geändert werden:
• COM1: Adresse 03F8, IRQ 4
• COM2: Adresse 02F8, IRQ 3

Die Windows-Konfiguration ist fehlerhaft.
Hinweis: Mit dem Windows-Programm “Ter-
minal” (Programm-Manager/Zubehör) kann
ebenfalls nicht auf die COM-Ports zugegriffen
werden.

Installieren Sie Windows erneut oder beheben Sie in
der Datei “System.ini” Fehler in der Konfiguration.
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GDC mit Systembus

Fehler Ursache Abhilfe

Beim Ausführen der
GDC-Uninstall-Funktion
werden Dateien im Sy-
stem-Verzeichnis und
Einträge in der Datei
“System.ini” nicht ge-
löscht.

Windows 3.11
Löschen folgender Dateien
im Windows-Unterverzeichnis “System”:
• PCANCLNT.DLL
• PCANCPL.CPL
• PCANSYM.DLL
• PEAKCAN.386
• VCANW.DLL
Löschen folgender Einträge in der Datei “System.ini”:
• device=peakcan.386;PEAK CAN DEVICE DRIVER
• [PEAKCAN]
• Hardware1=2,0x378,7
• Net1=GDC-PeakNet_1000, 1, 0x0014
• Net2=GDC-PeakNet_125, 1, 0x031C
• Net3=GDC-PeakNet_250, 1, 0x011C
• Net4=GDC-PeakNet_50, 1, 0x472F
• Net5=GDC-PeakNet_500, 1, 0x001C
Windows 95/98
Löschen folgender Dateien
im Windows-Unterverzeichnis “System”:
• PEAKCANL.VXD
• VCANW32.DLL
Löschen folgender Einträge in der Datei “System.ini”:
• device=peakcan1.vxd
• [PEAKCAN]
• Hardware1=2,0x378,7
• Net1=GDC-PeakNet_1000, 1, 0x0014
• Net2=GDC-PeakNet_125, 1, 0x031C
• Net3=GDC-PeakNet_250, 1, 0x011C
• Net4=GDC-PeakNet_50, 1, 0x472F
• Net5=GDC-PeakNet_500, 1, 0x001C
Windows NT 4.0
Löschen folgender Dateien:
• \WINNT\SYSTEM\DRIVERS\PEAKCAN.SYS
• \WINNT\SYSTEM\VCANW32.DLL

Absturz von GDC oder
Windows

Abziehen des PC-Systembusmoduls während
Windows läuft.

PC-Systembusmodul nicht von der Schnittstelle abzie-
hen bzw. auf die Schnittstelle stecken während Win-
dows läuft.
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6 Stichwortverzeichnis

A
Antriebsregler

suchen, 8
wählen, 9

B
Bedienoberfläche, 12

C
Codestellen, 14

D
Diagnose-Funktion, 11

F
FAQ, 22

Fehlerbeseitigung, 22

Fenster
Antriebe am Bus, 13
Hauptfenster, 12
Monitorfenster, 16
Parameterfenster, 13

Funktionsblock-Editor, 18

Funktionstasten, 18

G
Geräteadresse, 8

Gerätebeschreibung, 9

H
Hauptmenü, 17

I
IMP, 19

Installation von GDC, 5

L
Lieferumfang, 3

LWL, 4

M
Monitorfenster, 16

O
Offline-Modus, Antriebsregler wählen, 9

Online-Modus
Antriebsregler suchen, 8
Schnittstelle, 4

P
Parametermenü, 14

Parametersatztransfer, 17

R
RS232/485, 4

RSP, 19
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1 Introduction
The program Global Drive Control (GDC)is for comfortable commissioning and parameter setting of the
Global Drive controller series 8200 and 9300.
The main features of GDC are:
l Guided commissioning by means of drive-specific dialogs.
l Menu-guided parameter setting. The menu and the assigned codes are displayed at the same

time, similarly to the Windows Explorer.
l Parameter setting with and without direct connection to the controller via serial port

(online/offline operation). It is thus possible to set the parameters in advance.
l Simplified function-block parameterization for 93xx controllers.
l Automatic drive recognition when using the serial port.
l Communication via serial interface RS232/485, optical-fibre ring or system bus.
l Easy troubleshooting thanks to diagnostics functions.
l A monitor window displays 8 parameters which are cyclically updated. The values can be

displayed in different ways: pointer instruments, bars, trends, numbers).
l Oscilloscope function for 93xx controllers.

(93xx Servo as of software version 2.0, 93xx Vector as of software version 1.0)
l Function-block editor for 93xx controllers.
l PC parameter-sets comparison to find out the changes in parameter setting compared to the

Lenze default setting or the current drive setting.
l Complete parameter-set transfer between PC an controller with only one command.
l Print of the parameter settings for documentation, store/load of the drive configuration for data

exchange between different computers.
l Comfortable online help.

1.1 What is new?

Version Id No. Changes

1.0 10/98 00403781 First German edition

1.1 09/99 00410149 German/English edition

1.2 Scope of delivery

Scope of delivery Important

l 1 CD-ROM “Global
Drive Control”

l 1 Short Instructions

After receipt of the delivery, check immediately whether the scope of delivery
matches the accompanying papers. Lenze does not accept any liability for
deficiencies claimed subsequently.
Claim
l visible transport damages immediately to the forwarder.
l visible deficiencies/incompleteness immediately to your Lenze representative.
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2 System requirements
The following hardware and software requirements must be fulfilled to work with the program GDC:

Global Drive Control 16-bit version Global Drive Control 32-bit version

l Microsoft Windows 3.11 or Windows 95
l 16 MByte RAM

l Microsoft Windows 95/98/NT 4.0
l 32 MByte RAM

l IBM-compatible PC (CPU: 80486DX/33 processor or higher)
l Super-VGA display
l Hard disk with a minimum of 30 megabytes of available disk space
l CD-ROM drive
l free serial port for communication with the controller
Furthermore, we recommend the use of a mouse.

2.1 Ports supported by Global Drive Control

GDC supports the following ports for the communication between PC and controller:

Port Transfer
medium

Max. number
of controllers

Components required Order number

Serial
port (COM port)

RS232/RS485* RS232: 1
RS485: 31

2102IB fieldbus module EMF2102IB V001

PC system cable RS232/485, 5m EWL0020

Optical fibre 52 2102IB fieldbus module EMF2102IB V003

Optical-fibre adapter EMF2125IB

Supply unit for optical-fibre
adapter

EJ0013

Optical-fibre cable EWZ0007

Parallel port
(LPT port)

System bus 63 PC system bus module EMF2173IB

*At this time, RS485 is only supported by the Global Drive Control 16-bit version.

For communication with the controller connect the controller to the PC via the corresponding port
(COM-/LPT port).

Notes
l The program GDC is preset for the serial port COM2.
l Any other port can be configured in the communication settings in GDC. (�31)
l More information about the communication with the controller can be obtained from the GDC

Online Help.
l For more information about the fieldbus modules please refer to the corresponding Operating

Instructions.
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3 Software installation
Carry out the following steps to install the GDC software on your PC:
1. Start Windows.
2. Insert the Global Drive CD into your CD-ROM drive.

If your CD-ROM drive has AutoPlay enabled (Windows 95/98/NT),
the installation program will start automatically. In this case, skip to step 5.

3. Select in the Program Manager File → Run (Windows 3.11)
or in the start menu Run... (Windows 95/NT).

4. Enter the letter of your CD-ROM drive followed by “:\gdc_inst\setup.exe”
and acknowledge with Ok.

5. Follow the instructions of the installation program.

3.1 Selection of components

In the installation program of GDC you can select the components to be installed:

Fig. 1 Dialog box “Installation selection”

l Global Drive Control - GDC program data file and GDC Online Help
l Controller description... - Data for the corresponding controller required by GDC
l Online Help - Additional Online Help for the controllers 82xx/93xx
l CAN connection - Data for the communication via system bus required by GDC
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4 First steps with Global Drive Control

4.1 General

The program GDC distinguishes between online and offline modes.
l Offline:

There is no connection between PC and controller. The mode should be used for parameter
setting or documentation of the parameter setting in advance. No other components are
required, apart from the PC.

l Online:
GDC communicates with the controller via the serial/parallel port of the PC. This control mode
is required for the controller set-up.

4.2 Starting the program

l Windows 3.11:
Double-click the icon “Global Drive Control” in the program group “Global Drive Control”
indicated in the Program Manager.

l Windows 95/98/NT:
Click the entry “Global Drive Control” in the program group “Global Drive Control” indicated in
the start menu/sub menu Programs.
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After the first program start, the following dialog box is displayed. Here it is possible to choose between
online and offline mode.

Fig. 2 Dialog box “Lecom-A/B - Find drives”

Icon Function/Note

Find Finds the controller connected to the port COM2 (presetting) and starts GDC in the online mode.
When using other ports instead of COM2:
1. Select the icon Cancel, to close the dialog box.
2. Select in the menu Options → Communication, to change the communication settings.
3. Start the search again. (See chapter 4.3)
Further information about the communication settings can be obtained from the GDC Online Help.

� 32

Cancel Closes the dialog box without searching for the controller and starts GDC in the online mode. � 32

Offline Closes the dialog box without searching for the controller and starts GDC in the offline mode. � 33

Help Selects the corresponding information from the GDC Online Help.
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4.3 Find controller (online mode)

The dialog box “Find drive” is automatically opened when starting GDC in the online mode.
l The dialog box “Find” can also be activated as follows:

– Press the function key F2
– Select in the menu Controller → Find

– Click the icon in the tool bar

The following settings can be selected to find a drive (see alsoFig. 2):
l Search all baud rates:

Activate the control box to search all baud rates from 1200 to 19200 baud.
l Stop the search as soon as a controller has been found:

Activate the control box to cancel the search as soon as a controller has been found.
l Controller addresses:

Enter the range of controller addresses to be found.
Select the icon Find, to start the search or Cancel, to stop the search.
l Controllers connected to the bus are listed in the window “Controllers connected to the bus”.

(�37)
l GDC tries automatically to assign descripitions to the controllers found.

– If only one controller and the corresponding description were found, the description is loaded
immediately.

– If it is not possible to assign the description automatically, it is possible to select the
description for the controller manually.
To open the dialog for the description assignment activate the corresponding controller in the
window “Controllers connected to the bus”
or select in offline mode in the menu Controller → Select. (�33)
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4.4 Select controller (offline mode)

In the offline mode, the controller must first be selected manually over the dialog box “Assign inverter
description”.
1. Activate the dialog box “Assign inverter description” with one of the following possibilities:

– Press the function key F3
– Select in the menu Controller → Select

– Click the icon

�

Fig. 3 Dialog box “Assign inverter description”

2. Select the controller to be parameterized from the list�.
3. Click Ok, to accept the selection or Cancel, to stop the assignment of the controller

description.
If Ok is clicked, the controller description will be loaded in GDC.
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4.5 Short commissioning

After the controllerdescriptionhasbeen loaded in GDC, the dialogbox “Short commissioning” isopened
automatically.

4.5.1 Examples for the short commissioning dialog

�

ô í ÷ û ø

ù

Fig. 4 Dialog box “Short commissioning dialog” (examples)
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The functions in the dialog box “Short commissioning” depend on the loaded controller description.
They are therefore only explained as examples.
Further information about the corresponding dialog can be obtained from the GDC Online Help.

Field Icon Function/Note

� Setting changes in the selected configuration

ô Help Display of the Online Help
l With the icon Help the Online Help can be activated directly from any dialog box

and provide detailed information on the dialog box.
l General information about the use of the Windows Help is in the Windows

documentation.

í Start l Starts the controller
– only in online mode

÷ Stop l Stops the controller
– only in online mode

û Diagnostics Change to the dialog box “Diagnostics”
l Display of the monitoring configuration, operating time, error messages, etc.

ø Parameter menu Exits the short commissioning dialog and display of the parameter menu
l For more information about the parameter menu see chapter 4.6, “The Global

Drive Control user interface”. (� 36 )

ù Control Change to the dialog box “Control”
l With the dialog box “Control”, controller operation can be started easily.

– only in online mode
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4.6 The Global Drive Control user interface

4.6.1 Window types used in GDC

GDC works with four different window types.

Main window

� ô

í ÷

Fig. 5 Main window

The main window of GDC contains
l the main menu�, (�41)
l the tool barô, (�42)
l the status line í, (�43)
l and the GDC input field÷.
The main window is the application window of GDC. All other windows are document windows which
are only displayed in the application window. Functions for the arrangement of the application windows
are listed in the menu Window.



Global Drive Control

� 37GDC DE/EN 1.1

Drives connected to the bus

Fig. 6 Window “Drives connected to the bus”

All available controllers are listed in the window “Drives connected to the bus”. Select the controller
to be parameterized from this window.

Parameter window

Fig. 7 Window “Parameter window”

The parameter window is available after the corresponding controller description has been loaded in
GDC. In this window all controller-specific parameters can be set very easily.
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Note
These Short Descriptions explain the general use of the parameter window.
For more information see the GDC Online Help and the corresponding controller documentation.

The parameter window is subdivided into two sections:
l On the left side you find the parameter menu, here you can select the menu item to be set.
l The right side displays information and data about the point activated in the parameter menu,

for instance, in Fig. 7 a table with the codes relevant for speed operation.

Symbols in the parameter menu and their meanings

Menu item in the parameter menu, not selected.
l Double click the symbol to select the menu point.

Menu item in the parameter menu that provides sub-menu points. The sub-menu points are not indicated.
l Double click the symbol to indicate the sub-menu points.

Menu item in the parameter menu that provides sub-menu points. The sub-menu points are indicated.
l Double click the symbol to shield the sub-menu points.

Menu item in the parameter menu, selected.
l The right side of the parameter window displays information and data about the activated menu point.
l With menu items starting with “Dialog”, a dialog window will be opened instead.

– Click Back or Parameter menu, to close the dialog box again.

Codes of the controller can be accessed via tables indicated on the right side of the parameter window.

l Select the codes with the left/right mouse key or the pointer.
– The left mouse key opens the input dialog at the same time, if not, press Enter to open the

input dialog.
– The input dialog can only be opened if the selected codes permit overwriting of the controller

value.
l More information about the selected code can be obtained by pressing F1.
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The input dialog depends on the code type:

�

í

÷

ô

Fig. 8 Input dialogs possible for the display and change of codes

Indication of codes in the
input dialog

Notes

� List Select a new setting for the code from a list.
l The currently set value is marked in the list when the input dialog is opened.

ô Hexadecimal The value of the code is bit-coded.
l A list indicates all bits and their meanings.
l Toggle between 0 to 1 using the left mouse key or the blank key.
l The code can be entered as decimal or hexadecimal value.

í Decimal The code value can be entered within the indicated range using the keypad.

÷ Decimal, additional
step-by-step change
possible.

The code value can be entered within the indicated range using the keypad.
l The value can be additionally changed (fixed steps) using the Up and Down key.
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Buttons in the dialogs and their meanings

Ok The selected/entered value will be accepted, the input dialog will be closed.
l The value is transferred to the controller in the online mode.*

Acceptance The selected/entered value will be accepted, the input dialog will remain open.
l The value is transferred to the controller in the online mode.*

Cancel The input dialog will be cancelled, changes will not be stored.

Help Information about the selected code.

*Some codes can only be changed in the online mode if the controller is inhibited.

Monitor window

The monitor window displays values which are read cyclically by the controller.
l The monitor window is only active in the online mode.
l In the offline mode, the monitor window is automatically minimized to the symbol.

Fig. 9 Monitor window

l Click a window with the left mouse key to maximize it. A second mouse click restores the
previous window.

l Click a window with the right mouse key to open the dialog box “Monitor configuration”.
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4.6.2 Main menu

In addition to frequently used functions, which can be activated via, for instance, the tool bar or the
function keys, the GDC main menu provides many special functions grouped in sub-menus according
to their functionality.
Depending on the controller and the menu (online/offline) selected, it is possible that a sub-menu or
its functions are not highlighted. Not highlighted functions cannot be activated.

Sub-menu Functions Notes

Controller l Find/Select/Start/Stop
l Communication parameter
l Close GDC

� 32, 33

Drive
parameters

l Parameter-set transfer PCÛ controller
l Load/store/print parameter

l Sub-menu will only be displayed in
the online mode

� Online Help

FB editor l Special function-block editor function l Sub-menu will only be displayed
when the function block editor is
activated

l Only 93xx controllers

� 44

Oscilloscope l Special oscilloscope functions l Sub-menu will only be displayed
when the oscilloscope is activated.

l Only 93xx controllers as of software
version 2.x

� 45

Tool l Activation of used-defined tools directly via
GDC

l Activation of optional GDC components (FB
editor, oscilloscope)

l External programs can be integrated
into this sub-menu. They can then be
activated directly via GDC.

� Online Help

Options l Program presettings � Online Help

Window l Window arrangement

Help l Display of the Online Help
l Program information
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4.6.3 Tool bar

The tool bar provides easy access to the most frequently used functions. Many functions can also be
activated by pressing the function keys on your PC keyboard.

Activate
button

Deactivate
button

Function
key

Function

F1 Indicates context-sensitive help
l General information about the use of the Windows Help is in

the Windows documentation.

Close drive window.

F2 Find controller � 32

F3 Select controller � 33

F4 Change-over between online and offline mode � 32
� 33

F5 Transfers parameter sets from the PC to the controller
l only in online mode

F6 Transfers selected parameter from the controller to the PC
l only in online mode

F7 Transfers parameter sets from the controller to the PC
l only in online mode

F8 Starts the controller.
l only in online mode

F9 Stops the controller.
l only in online mode

Starts the function-block editor.
l Only 93xx controllers

� 44

Starts the oscilloscope function.
l Only for controllers

– 93xx servo as of software version 2.0
– 93xx vector as of software version 1.0

� 45
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4.6.4 Status line

� îô ÷í ùøû ü

Fig. 10 Status line

Information indicated in the status line

� Information about controller-specific parameter menus.

ô/í Status information for drive-specific dialogs.

÷ TRIP: Controller error

û RSP: Controller is inhibited

ø IMP: Pulse inhibit set in the controller.

ù Active mode (online/offline)

î Online address (CAN or LECOM-A/B)

ü Time
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4.7 Function-block editor

The function-block editor is a powerful tool which analyses signal configurations in Lenze 93xx
controllers.

l Click the button in the tool bar, to open the dialog box “FB editor”.

Fig. 11 Dialog box “FB editor”

Selection of signal configuration

Use the mouse pointer to connect or disconnect function blocks. The parameters of the function blocks
(e.g. acceleration ramp or maximum speed) can also be set with the function-block editor.

Diagnositics of signal configuration

Actual values, which are cyclically updated, can be indicated at the inputs and outputs of the function
blocks. The signals can be traced by clicking the function blocks. This helps to find faults in the signal
flow. Furthermore, the function-block editor informs about the processing sequence of the function
blocks.

Analysis of signal configuration

All function blocks used for the signal configuration can be displayed as graphics. With the mouse
pointer it is possible to trace signals (e.g. speed setpoint) through the whole signal configuration. The
parameter of the function blocks indicate the corresponding function.
Further information about the function-block editor: Menu Help → Function-block editor.
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4.8 Oszilloscope function

GDC offers an oscilloscope function for 93xx controllers, software version 2.0 (93xx vector, software
version 1.0) and higher.

l Click the button in the tool bar, to open the dialog box “Oscilloscope”.

Fig. 12 Dialog box “Oscilloscope”

The oscilloscope function is used to measure signals which are processed by the controller. For this,
the controller is equipped with a function block (OSZ) that works like a storage oscilloscope. This
function block can measure and record up to four analog signals at the same time. The oscilloscope
is triggered either over an additional digital input or one of the four analog channels.
The data are stored in the controller. After a measurement, the data are transferred to the PC and
displayed by means of the oscilloscope function in GDC.
The communication between controller and visualization function is only possible with
l LECOM-A/B
l System bus
Further information about the oscilloscope function: Menu Help → Oscilloscope.
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5 Appendix

5.1 Frequently asked questions and answers

Fault Cause Remedy

Parameter-set files
cannot be read.

You have tried to read parameter-set files
generated with the DOS program “Lemoc2”.

GDC uses a different file format to store the
parameters.
Transfer the parameter set from the controller to the
PC and store it under GDC.

No communication with
the controller.

Wrong PC system cable. Check system-cable wiring.
(For the assignment of the system cable see: GDC
Online Help.)

Controller is switched-off or the
LECOM-A/B-Modul 2102 is not supplied with
voltage.

Check the voltage supply and connection of the
controller.
With external supply, check the voltage at terminals 39
and 59 (see Operating Instructions for the controller).

Wrong COM port. Select menu Options → Communication, to change
the selection of the COM port.

Port parameters are not set correctly The port parameters can be changed under the
Windows Control Panel:
l COM1: Address 03F8, IRQ 4
l COM2: Address 02F8, IRQ 3

Faulty Windows configuration.
Note: It is not possible to access the COM
ports using the Windows program “Terminal”
(Program Manager/Accessories).

Reinstall Windows or eliminate the configuration fault
in the file “System.ini”.
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GDC with system bus

Fault Cause Remedy

Some files in the system
subdirectory and entries
in the file “System.ini”
will not be deleted when
GDC is uninstalled.

Windows 3.11
Delete the following files
in the Windows subdirectory “System”:
l PCANCLNT.DLL
l PCANCPL.CPL
l PCANSYM.DLL
l PEAKCAN.386
l VCANW.DLL
Delete the following entries in the file “System.ini”:
l device=peakcan.386;PEAK CAN DEVICE DRIVER
l [PEAKCAN]
l Hardware 1=2.0x378.7
l Net1=GDC-PeakNet_1000, 1, 0x0014
l Net2=GDC-PeakNet_125, 1, 0x031C
l Net3=GDC-PeakNet_250, 1, 0x011C
l Net4=GDC-PeakNet_50, 1, 0x472F
l Net5=GDC-PeakNet_500, 1, 0x001C
Windows 95/98
Delete the following files
in the Windows subdirectory “System”:
l PEAKCANL.VXD
l VCANW32.DLL
Delete the following entries in the file “System.ini”:
l device=peakcan1.vxd
l [PEAKCAN]
l Hardware1=2,0x378,7
l Net1=GDC-PeakNet_1000, 1, 0x0014
l Net2=GDC-PeakNet_125, 1, 0x031C
l Net3=GDC-PeakNet_250, 1, 0x011C
l Net4=GDC-PeakNet_50, 1, 0x472F
l Net5=GDC-PeakNet_500, 1, 0x001C
Windows NT 4.0
Delete the following files:
l \WINNT\SYSTEM\DRIVERS\PEAKCAN.SYS
l \WINNT\SYSTEM\VCANW32.DLL

Crash of GDC or
Windows

System-bus module was removed during
Windows operation.

Do not connect or disconnect the system-bus module
while Windows is running.
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